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Section 1:   Styles 

A style is a group of formats, such as bold fonts and margins, that you can apply to 
your text.  By giving the style a name, you can apply the group of formats to any part 
of your text with a single keystroke, by choosing the name from the styles box on the 
ruler.  If you want to change the look of your document, you can change the definition 
of the style, and automatically all paragraphs with that style will change. 
 
Word supplies several automatic styles.  These can be redefined, but not deleted or 
renamed.  When you open a new document with a NORMAL template, the styles box 
gives you the options normal, heading 1, heading 2, heading 3 and body te xt 
indent .  To find out what formatting is contained in these styles choose Styles and 
Formatting  from the FORMAT menu.   
 
The Styles and Formatting  task pane will display.  Hover your mouse pointer over 
one of the headings to display the formatting applied. 
 

 

·  Every document and template has a default style sheet 

·  When you begin typing word applies the normal style to each paragraph you type. 

·  Styles you create in a document are saved with the document. 

·  Styles can be added to the default template, NORMAL.DOT, making those styles 
available to all new documents created. 

·  Four types of styles are available, Paragraph, Character, List and Table styles. 
 



 

© Senan Solutions  Page 2 

Normal Style 
 
When you begin typing a document, Word applies the Normal style to all text that you 
type until you apply a different style. 

Paragraph Styles 

A paragraph style contains all features that control a paragraphs overall appearance 
– the font size, line spacing, text alignment, tab stops, borders and other formats that 
effect the whole paragraph. 

·  Paragraph styles are applied to whole paragraphs. 

·  Paragraph styles appear in bold in the styles list. 

Character Styles 

A character style applies the formats of the Font command to words within a 
paragraph. 

·  Character styles are not bolded in the style list and an a is displayed. 

List Styles 

A List style applies numbering styles to paragraphs.  Word supplies a number of list, 
but the numbering is not always as your company requires. 
 
·  List styles are not bolded in the style list and a picture of the bullet button is 

displayed. 

Table Styles 

Enables you to create an Autoformat for Tables. 
 
·  Table styles are displayed within a border and a picture of a table. 
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Applying Styles to Existing Text 
 
1. Select the text you want to format 

·  Select the text, paragraphs or table you wish to effect. 

2. Choose the style from the styles box on the toolbar or from the Styles and 
Formatting pane. 

Using the keyboard to apply styles: 
You can apply commonly used built-in styles to selected text by using the shortcut 
keys. 
 

To Apply Keystroke 

Normal Ctrl+Shift+N 

Heading 1 Alt+Ctrl+1 

Heading 2 Alt+Ctrl+2 

Heading 3 Alt+Ctrl+3 

Applying Styles as you type 
1. Select the style you want to use. 
 
2. Type the text and press Enter  
 
As you press Enter you will notice that the style returns to the Normal style. 

Creating a Paragraph Style 
The easiest way to do this is by example. 

1. Format some text and select it 

2. Click the New Style  button in 
the Styles and Formatting  
pane. 

3. Type a new style name 

4. Choose OK 

5. Adds the new style to the list 
 
You now have this new style available 
on the menu, for use elsewhere in the 
document. 
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Defining the Following Paragraph 
When you create your own style you will notice that when you press Enter it does not 
automatically return to the Normal style.  All styles in a document are originally 
created from the Normal style.  The default for Word is, that the Following 
Paragraph style  is the same as the current style.  To change this: 

1. Hover your mouse pointer over the 
style name in the Styles and 
Formatting pane. 

2. Right mouse click and choose Modify  

3. Select Normal from the Style for 
following paragraph box. 

4. Click OK 
 

 

 

Creating a Paragraph Style Using Commands 

1. Click the New Style  button in the Styles and Formatting pane 

2. Type a name for the style 

3. In the Style Type  box, make sure that Paragraph  is selected 

4. In the Style for following paragraph  box, select the style to follow this style. 

5. Choose the Format button and select the formats to be applied. 

6. Choose OK to define the style. 
 
 Font  Allows you to change font, point size, add enhancements or 

change line spacing. 
 
 Paragraph  Enables you to set the alignment, indentations, line spacing 

and pagination. 
 
 Tabs You can set tabs purely for use with this style 
 
 Borders  Create graphic lines, boxes, shading etc 
 
 Language  If this style is always typed in a foreign language you assign 

the language dictionary to this style and if the dictionary is 
available it will be used in spell checking. 

 
 Frame Similar to borders except that borders always use the full 

margin, whereas a Frame will only border the text and will 
expand with the text. 

 
 Numbering  Applies heading Numbering or Bullets 
 
 Shortcut key  Assign a quick key to apply the style. 
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Creating a Character Style 

1. Click the New Style  button in the Styles and Formatting  pane 

2. Type a name for the style 

3. In the Style Type  box, make sure that Character  is selected 

4. Choose the Format button and select the formats to be applied. 

5. Choose OK to define the style. 
 

Create a new list style  
 
In addition to the built-in list styles that come with Microsoft Word, you can create 
your own list style to apply similar alignment, number or bullet characters, and fonts 
to lists. 
 

1. If the Styles and Formatting  
task pane is not open, click 

Styles and Formatting   
on the Formatting  toolbar.  In 
the Styles and Formatting  
task pane, click New Style .  

2. In the Name box, type a name 
for the style.  

3. In the Style type  box, click 
List .  

4. Select the options that you 
want, or click Format  to apply 
more advanced options.  

 
 

 

 
Note To use the new style in new documents based on the same template, select 

the Add to template  check box. Word adds the new style to the template 
that is attached to the active document.  
 
You can reuse a new list style by selecting it in from the Styles and 
Formatting  task pane or from the List Styles  tab in the Bullets and 
Numbering  dialog box (click Bullets and Numbering  on the Format  menu).  
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Create a new table style  
In addition to the built-in table styles that come with Microsoft Word, you can create 
your own table style to provide a consistent look to borders, shading, alignment, and 
fonts in tables. 

1. If the Styles and Formatting  task pane is not open, click Styles and 

Formatting  on the Formatting  toolbar  

2. In the Styles and Formatting  task pane, click New Style .  

3. In the Name box, type a name for the style.  

4. In the Style type  box, click Table.  

 

5. Select the options that you want, or click Format  to see more options. 

6. From the Apply formatting to:  box select the different elements of the table 
that you wish to format i.e., Header Row and shade. 
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Note: You can reuse a new table style by selecting it in the Styles and Formatting  
task pane, or from the Table AutoFormat  dialog box (click Table 
AutoFormat  on the Table menu, and then under Category , select User-
defined table styles ). 

 

Modifying a Style 
If you do not like the pre-set formats for the built-in styles you can modify their 
formats just as you can modify styles you create yourself. 
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You can modify styles using text that is already formatted with the style (Example 
Text) or you can use the Style Command. 

Example Text 

1. Select a paragraph formatted with the style you want to change. 
 
2. Modify the formats of the paragraph by using the formatting toolbar and menu 

commands. 
 
3. Hover the mouse over the style name in the Styles and Formatting  task 

pane. 
 
4. Right mouse click and choose Update to Match Selection  
 
The style will be updated throughout the document. 

Style Command 
To modify the formats of a style using the style command: 
 
1. Hover the mouse over the style name in the Styles and Formatting  task 

pane. 
 
2. Right mouse click and choose Modify  
 

 
 

3. Choose the Format  button and modify the style’s formats. 
 
4. Click OK to redefine the style 
 
Text formatted with the modified style is updated throughout the active document. 

Adding a Style to the attached Template 
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In the Modify dialogue box you have the option of adding a style to the template.  This 
will add the style to the currently attached template.  So that it will be available for all 
new documents based on this template. 
 

Automatically Update 
 
Use this option with caution.  When this box is ticked any changes you make to a 
style will automatically affect all text where the style has been applied.   Therefore 
you do not need to modify.  This can be very dangerous. 
 

Copying Styles between Templates/Documents 
 
You can copy styles from one document or template to another so that you don’t have 
to create or modify the same style twice. 
 
1. From the Show  box on the Styles and Formatting  pane, select Custom  
 

 
 
2. Click the Styles  button 
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3. Choose the Organizer  button 
 
On the left; Word displays the styles used in the active document or template.  Styles 
used in the Normal Document template are listed on the right. 
 

 
 
4. Ensure that both the target document and source document is listed. 
 
5. Select the style to be copied from one to the other and choose the Copy  

button. 
 
6. Choose Close . 
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Section 2:   Table of Contents 

 
There are two ways to insert a table of contents; one is using Paragraph headings i.e. 
Styles and one using fields.  The advantage of using fields is that you are not limited 
to heading text for your contents.  You can also create lists of illustrations, diagrams 
etc using the same technique. 

Inserting a Table of Contents using Styles 
 
First, format your document using the built in heading styles, Heading 1 through to 
Heading 9.  Then, to insert a table of contents you need to first place your cursor in 
the correct position in the document where you wish the table of contents to be 
generated. 
 
1. As a Table of Contents normally appears on the first or second page of the 

document, position your cursor on this page and head it TABLE OF 
CONTENTS 

 
2. Press Enter twice to ensure that the table of contents appears below the 

heading 
 
3. Choose Insert, Reference, Index and Tables  
 
4. Click on the Table of Contents  tab 
 

 
 
5. Select the desired Format  

 
Experiment with Right Align Numbers on/off , Try Tab Leader 

 
Options  This will allow you to decided on which styles should be used to create the 

table of contents and also whether in fact you wish to use Field Codes 
rather than styles. 

 
6. Choose OK 
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 Word generates the Table of Contents at the cursor location 
 
Note: Note if the page numbers or headings change you will need to generate the 

table of contents again. Go back to the Insert menu and re-create the TOC.  
Word will ask if you want to replace the current TOC and choose Yes. 

 

Tables of Figures and Pictures 
If you have used the Caption command and the Insert menu to add captions (such as 
“Figure 3:Tuna Fish”) to drawings, tables and other items, you can easily include the 
captions in a table of figures. 

1. Position the insertion point where you want to insert the table of figures. 

2. Choose Insert, Index and Tables  

3. Choose the Table of Figures  Tab 

4. Select a format 

5. Select the type of caption label you want to include 

6. Choose OK 
 
Alternatively if you have not used the Caption  option proceed as follows to create a 
table of figures as well as a table of contents. 

1 Insert a TC field in the normal way.  To do this, position the insertion point 
where you want to mark the entry and choose the Insert  menu and choose 
Field .   

2 Choose Index and Tables  from the categories list and choose TC from the 
field list.   

 

 
3 Click in the Text Entry box, and type the text to appear in the Table of 

Contents.    
 
TC entry in doc with multiple tables Activate this if you want to create 

TOC for graphics and TOC for 
figures. 
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Outline Level Where do you want this entry to 
appear in the TOC.  Heading 1 is 
Level 1, Heading 2 is Level 2. 

 
Suppresses page number Do you want the page number to 

appear. 
 

Creating a TOC from TC fields 

1 Position insertion point where you want the Table of Contents to appear. 

2 Choose Insert Field 

3 Type toc  in the field codes box, followed by a backslash and the table-id you 
have chosen. i.e.  

 
Note:  To generate the table of contents for either of these two options you can up 

date manually. 
 
1. Place your cursor on the TOC field and press F9 
 
 The table will be updated. 

Updating a Table of Contents 
When information changes in the document, the table of contents will need to be 
updated. 
 

1. Click in the Table of Contents and then click your right mouse button 

 
 

2. Choose Update Field  
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Section 3:   Indexing 

 
Creating an index consists of inserting Index Entry (XE)  fields in the text, and an 
INDEX field where you want the index to be created.  The INDEX field can be 
updated each time the page numbers change or if you add new index entry fields.  
 
You can create an index entry: 

·  For an individual word, phrase, or symbol.  
·  For a topic that spans a range of pages.  
·  That refers to another entry, such as “Transportation. See Bicycles.”  

  
Note:  View Field Codes to see Index Entry Fields 

Inserting an Index Entry 

1. Select the text that you would like to appear in the Index. 

2. Choose Insert, Reference, Index and Tables  

3. Choose the Index  Tab 
 

 
 

4. Choose Mark Entry 
 

  
 

5. The Main Entry  box is a level 1 in the final Index 
 
6. The Subentry  box appears as a level 2 i.e. a subheading of the Main Entry 
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Page number: Bold Turn on if you want bold page numbers 

 Page number: Italic Turn on if you want italic page numbers 
 
7. Choose Mark 
 
8. When viewing Field Codes  you will see the field.  Without it, you will not see 

the index. 
 

Inserting Multiple Level Entries 

1. Position the insertion point immediately after the text you want to index. 

2. Select Insert, References, Index and Tables, Mark Entry  

3. Type the first level in the Main Entry  box 

4. Type the second level in the subentry  box 

5. Choose Mark 
 
Note: Placing the XE field after the text ensures that the page numbering is correct.  

Otherwise Word might insert a page break between your XE field and the text 
you are indexing. 

 

Creating an Index 
Once the Index entries have been marked you can create the Index - which would 
normally appear at the end of a document. 
 

1. Position the insertion point where you want the index to appear. 

2. Choose Insert, Reference, Index and Tables  

3. Choose the Index  Tab 
 
4. Choose the desired format, by experimenting with the options 
 
5. Choose OK 
 
6. When viewing Field Codes  you will see the field.  Without it, you will not see 

the index. 
 

Updating the Index 
 
Either use the update field key (F9) 
or choose Insert Index and Tables to update the index, and confirm you wish to 

replace. 
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Section 4:   Automatic Paragraph Numbering  

In the Introductory course we show how to number paragraphs by typing the number 
and then using either the Ruler or Ctrl key shortcuts to shape the paragraphs as 
hanging paragraphs.  This is fine for short documents, but with longer documents 
Automatic Paragraph Numbering (called Outline Numbering) is a much better feature 
to use. If you add, delete, or move items in a numbered list, Word updates the 
numbering for you. 
 

 
 

Word comes with two predefined multilevel formats. You can define additional 
formats and also edit the existing formats.  Choose the Outline Numbered  tab from 
the  Bullets and Numbering  command on the Format menu to view the predefined 
formats. 
 
 

Creating a Multilevel List 
 
1. Choose Bullets and Numbering  from the Format  menu. 
 
2. Select the Outline Numbered  tab, and then select the list format you want. 
 
3. Choose the OK button.  The first number will appear in your document.  Now 

type the first paragraph and then press ENTER only once when you have 
finished typing it.  

 
 When you are typing using multilevel numbering you cannot press the Enter 

key twice between paragraphs to get extra spacing, because each time you 
press the Enter key word will number the blank paragraph.  You must 
increase the spacing before the paragraph, and only press Enter once at the 
end of each paragraph. 

 
4. Choose Paragraph  from the Format  menu and change the spacing Before  

to 12 points (which equals one line). Choose the OK button. 
 
 A much quicker way to do this is to press CTRL + 0  (Zero) to add or 

remove 12 points of space before the current paragr aph.   
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Changing the Level of Numbering 
When you start typing using this feature you will be on the first level of numbering.  To 
change to the next level proceed as follows 
.   

Do this To achieve 

Tab or  Indents the paragraph and inserts the next level number 

Shift+Tab  or  Returns to the previous level number 

 
Please note that for the keystrokes to work you have to have the cursor at the 
beginning of the paragraph. 

Skipping or Stopping the Numbering 
 
To skip a number or to stop the numbering press Enter at the end of the current 
paragraph and then Control+Q  remove the resulting number and return to the normal 
style. 
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Smart Tags and Restarting the numbering 
As you switch Outline numbering on and off you will find that smart tags appear on 
the screen when you restart the numbering.  If you have stopped the previous list at 
5, you will have a choice of restarting the numbering at 6, or restarting from 1 again.  
You can use the Smart Tags to make this choice, or alternatively you can go back to 
the Format, Bullets & Numbering  dialog box and choose Restart Numbering  or 
Continue Previous List  from the Outline Numbering Dialog box.   
 

 
 
 

Starting at a Different Number 
 
You may not always want to start your paragraph numbering from one.  To start at a 
number other than one. 
 
1. Place the insertion point in one of the numbered paragraphs. 
 
2. Choose Bullets and Numbering  from the Format  menu, and then choose 

the Outline Numbered  tab, click on the Customise  button.  When the 
Customise Outline Numbered List box appears Type the value you wish 
numbering to start from in the Start At  box. and then choose OK.   

 

 
 

Changing the Style, Position and Alignment of Numbe ring  
The Customise Outline Numbered List dialog box above can be used to modify 
number formats.  For example, you may want to increase the “Aligned At ” setting for 
the Number Position or the “Indent at ” for the Text position.   
 
Once you make a change in this dialog box it is a semi permanent change, which 
means it remains changed until you change it again or rest it. 
 
If you do reset, you reset all the numbering, not just one change you have made to it. 
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To reset the numbering back to the default settings : 

 
1. Choose Bullets & Numbering  from the Format  menu and then choose the 

Outline Numbered  tab. 
 
2. Choose the style of numbering you wish to reset back to the default and then 

choose the Rest  button at the bottom left of the dialog box as below. 
 

Designing/Saving a List style to use again 
The List Styles  tab allows you to create a layout for numbering and indents and give 
the list a name so that you can use the same layout (Style) of numbering again. 
 

 
 

1. From the Format menu choose Bullets and Numbering. 

2. Select the List Styles  tab. 

3. Click the Add  button 

4. Type a name for the Style 

5. Notice that the Style type has 
automatically defaulted to List  

6. Click the Format  button 

7. Choose Numbering  

8. Click the Customise  button 
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9. Choose the following for each level of your  style: 

The Number Style 

The Number Position 

The Text  i.e., wrapping Position 

10. When completed choose OK and OK again 

 
Note To use the new style in new documents based on the same template, select 

the Add to template  check box. Word adds the new style to the template 
that is attached to the active document.  
 
You can reuse a new list style by selecting it in from the Styles and 
Formatting  task pane or from the List Styles  tab in the Bullets and 
Numbering  dialog box (click Bullets and Numbering  on the Format  menu).  

1. Highlight the level 
you wish to 
change. 

2. Choose the style 
of numbering. 

3. Type any character 
after the number. 

4. Set the Indent 
position. 
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Attaching a Style to a Numbering Level 
The second row of examples in Outline Numbering is designed for Headings and the 
levels are linked to a Heading Style..  If you do not want all Paragraph levels to be 
headings you can link another style to a level. 
 

 
 

1. To link to another style you must first create a style or use an existing style. 
 
2. Add Outline numbering to Headings 
 
3. Choose the Customise  button in Outline numbering 
 

 
 

4. Select a level and change the Link level to Style to the style you would like to 
create for this paragraph level. 

Sequence to follow: 

1. Design Heading 1 Style 
2. Design Body text style 
3. Design Body Text style 2 
4. Modify Normal to be indented. 

 
5. Turn on Outline numbering on Headings 
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If you do not want all Paragraph levels to be headings you can link another style 
to a level. 

 

Link Levels to a Style 

 

 
 
Note: Level 3 in the dialogue box above has been linked to Body Text. 
 

Shortcut keys for Paragraph formatting 

 

Shortcut Keys Do this 

Control+0 Inserts 12 pt before the paragraph 

Control+Q Removes paragraph formatting 

Control+T Sets hanging indent at first tab stop 

Control+Shift+T Moves hanging indent to left 

Control+M Sets indent at first tab stop 

Control+Shift+M Decreases indent 
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Section 1:   Dividing a Document into Sections 

 
You can divide a document into any number of sections and format each section the 
way you want.  For example, you might want to start the document with a landscape 
orientation, and then change to a portrait orientation.  A section can be as short as a 
single paragraph or as long as an entire document. 
 
When you start a document there are no section breaks because the entire document 
consists of one section.  You create a new section when you want to change any of 
the following elements in a specific part of a document. 
 

·  Paper size, page orientation, or margins. 
·  Number of newspaper style columns. 
·  Format, position, and sequence of page numbers. 
·  Contents and position of headers and footers. 
·  Line numbering. 
·  Vertical alignment of text on a page. 

 
 

Creating a New Section 

 
1. Position the insertion point where you want to start a new section. 
 
2. From the Insert  menu choose Break . 
 

 
 
3. Under Section Breaks, select the option which describes where you want the 

next section to begin.   
 
5. Choose the OK button. 

6. Assuming that you are viewing your codes you will see the following: 
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Deleting a section break. 

 
In normal view, select the section break you want to delete, and then press 
BACKSPACE or DELETE. 
 
When you delete a section break, you also delete the section formatting for the text 
above it.  The text becomes part of the section that follows it, and it assumes the 
formatting of that section. 
 
In simple terms………….the section break containing the formats for the section, 
appears at the end of the section. 
 

Types of Section Breaks 

 

Type of break Has this effect Example 

Next Page Word breaks the page at the 
section break.  The new 
section starts on the next 
page. 

Changing from portrait 
to landscape 
orientation. 

Continuous Word inserts a section break 
and begins the new section 
on the same page. 

To have multiple 
newspaper columns 
on a page and then 
change back to one 
column format.  

Odd Page Word begins the new section 
on the next odd-numbered 
page. 

Chapters that begin on 
odd-numbered pages. 

Even Page. Similar to Odd Page, but 
Word begins the new section 
on the next even-numbered 
page. 
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Printing in Landscape 
 

3. Select Page Setup  from the FILE menu. 

4. Select the Paper Size tab.  The following dialog appears: 

 

5. Select the paper size and orientation required and select OK. 
 
By default Word will change the “Whole document” to Landscape.  If you only want 1 
page in Landscape in the middle of a document, choose “This point forward” in the 
Apply to: box. 
 
At the bottom of the Landscape page return to the Page Setup dialog box and choose 
Portrait “From this point forward ” 

Trouble Shooting Landscape 

 
You may find that placing an odd numbered page into landscape messes up page 
numbering and if you go into Print Preview you will see that Word has inserted a 
blank portrait page – that you cannot see in the document.  This is caused by Word 
inserting a Section Break Odd Page , which forces the following page after the section 
to be odd, thus creating a blank page. 
 
To overcome this, do not use the “From this point forward ” option in Page Setup, 
but insert your own section breaks ensuring that they are Section Break Next Page. 
 
1. Insert a Section Break Next Page  
 
2. Place the cursor under the section break (in the new section). 
 
3. File, Page Setup, Papersize, Landscape  
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4. Ensure that the Apply to  option is set to This Section . 
 
5. When you wish to return to Portrait follow steps 1-3 above, choosing Portrait 

instead of Landscape. 

Numbering the third page in the document as 1  
Documents that have a cover page and a table of contents page often want to start 
the page numbering from page (1) further on in the document. 
 
To do this: 
 
1. Make sure that the page where you wish to re-start the numbering has a 

Section Break Next Page above it.  To insert a Section Break, position the 
cursor and then choose Break  from the Insert  menu and choose Section 
Break Next Page . 

 
2. Make sure that the cursor is in the new section and create a Header/Footer 

by choosing Header/Footer  from the View menu.   
 
3. Position the cursor in the Header or Footer, and click to switch off the Same 

as Previous  button.  If you do not do this the page numbering will also 
appear on the pages in front of the one you are working on. 

 
4. Click the Page Number  button on the Header/Footer toolbar.  A page 

number will appear in your document.  Now go get the page number you 
want you must re-start the page numbering in the section you are in. 

 
5. Choose Page Numbers  from the Insert  menu and choose the Format  

button.  Click to choose Start at  at the bottom left hand corner.  Page one 
will automatically appear in the box.  Click to choose OK and Close . 

 
6. The page number should now be “1” and will not appear on the previous 

pages in your document. 

Changing the Header/Footer within a Document 
If your document is divided into chapters or sections you may wish to change the 
header or footer within the document.   
 
The only way to do this is to break the document up into sections. 
 
1. Insert a Section Break where you wish the header/footer to change by 

choosing Break  from the Insert  menu and then choosing Section Break 
Next Page . 

 
2. Make sure that the cursor is positioned in the new section. 
 
3. Choose View Header/Footer  and you are positioned in the header window.  

Before you can make any changes you must switch off the Same As 

Previous  button.  If you do not do this any changes you make in the 
header/footer will affect the previous section.   

 
4. Making sure that the Same as Previous button is now off, edit the existing 

header to make a new header for your second section.   
 
 



 

© Senan Solutions  Page 27 

Section 2:   Using Fields 

Fields are special codes that instruct Word to insert information into a document for 
example, you can use the DATE field to insert the current date each time you print a 
particular document. 
 
Usually you see the result of a field, for example the date in a document. A field either 
shows the result of the field or the field code which produces the result. 
 
You can use fields to insert the date, filename, Username, Author, formula, Page 
numbers, Revision Numbers, etc. 

Insert Fields 
To insert a field: 
 
1. Choose Field  from the Insert  menu 
 

 
 

2. Under Categories, select a field category.  To see all field types listed 
alphabetically, select ALL. 

 
3. Under Field Names, select the field type you want. 
 
4. To add instructions to the field, select Options on the right of the dialogue 

box.   
 
5. Choose the OK button to insert the field into your document. 
 
 

Insert Fields from the Keyboard 
When you become familiar with the syntax (format) of the field commands you can 
type the field codes directly into your document. 
 
1. Position the insertion point where you require the field code. 
 
2. Press Control F9  to produce the field characters {} .  Type the field code 

within the characters, including any switches (options) you require.  Press the 
right arrow key to move the insertion point outside the field characters. 
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Viewing Field Results or Field Codes 
There are two way to view fields, as field results or field codes.  Field results are 
visible in the document as text or graphics.  Field codes are instructions enclosed in 
field characters {} .  Field codes tell Word the result to produce and how to format it. 
 

To view field codes for a single field 

1. Click the insertion point in the field and click with your right mouse button to 
display the quick menu.   

 
2. Choose Toggle Field Codes.  
 

To view field codes for the entire document 

1. Press Alt F9.   Press Alt F9  again to toggle field codes on/off. 
 

Updating Fields 
A field only runs itself when you first insert it into the document.  Sometimes it may be 
necessary to update (re-run) a field. For example, if you use the FILENAME field to 
produce the filename in a Header or Footer, and then change the name of the 
document, you will need to update the field to show the new filename. 
 
To update fields 
 
1. Select the field or fields you wish to update and press F9. 
 

Field Shortcut Keys Summary 
 
You can use the following shortcut keystrokes when working with fields. 
 

To do Press 

Insert a Field Control F9 

Update one or more fields F9 

Toggle between seeing field results and field 
codes for selected fields 

Shift F9 

Toggle between seeing field results and field 
codes for the entire document 

Alt F9 

Select the next field F11 

Selected the previous field Shift F11 
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Section 3:   Using Word Fields in Merge 

Word provides a few fields that can be useful for customising the main document.  To 
see these fields click the Insert Word Field  button on the Mail Merge toolbar.  The 
most useful of these fields are described below. 

If…  Then… Else 
The ‘If, Then, Else ’ field can be very useful if you want to customise a letter when a 
certain condition is met. 
 
In the example below IF the salary is greater than or equal to £25,000 the employee 
will be paid a 25% bonus otherwise they will be paid a 10% bonus.  
 

 
 
To use this field; click where you want to include the text in your main document and 
choose If, Then, Else from the Insert  World Field  button on the Mail Merge toolbar.  
 
 

Fill-in Field 
A Fill-in field can be used to place variable 
text in each letter.  For example, if you are 
inviting clients to an event you can use the 
field to insert the date of the event into each 
letter.  If you tick the Ask once box, Word 
asks for the information once and then 
places it in every letter.  If you don’t tick this 
box Word asks for the information per letter, 
so if you have 100 letters you will have to 
type the information 100 times.  Think 
carefully before using this.  It would probably 
be easier to just type the information into the 
letter or alternatively if it changes per record, 
include it in the data source. 
 
To use the Fill-In field, click in the letter where you want the variable information to go 
and then chose the Insert Word Field  button on the Mail Merge toolbar and click Fill-
In.  The following dialog box appears. The Prompt is the title of the dialog box that 
prompts you to type the information and anything you type in default text will be used 
unless you change it when you run the merge. 
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Run the merge as normal and the fill-in dialog box will appear as the first letter 
appears on the screen.  Type in the relevant information and choose OK.  
 

Ask Field 
Sometimes you may want to include different information in your letter (main 
document) each time you run the mail merge and it isn’t convenient to change the 
main document each time.  If the piece of information is to be entered only once in 
each document you should use a Fill-in Field . If the information is going to be 
repeated several times in each document, use an Ask Field . 
 
For example, perhaps you frequently send letters out to parents inviting them to 
attend an opening evening, but each time you do the letters the date of the event 
changes.  You could open up the main document and just type the date straight in or 
alternatively you can include an Ask field in your main document.  When you include 
an Ask field Word will prompt you using a dialog box for the necessary information 
each time you run the mail merge. 
 
To use an Ask field you need to do two things, firstly place a bookmark in the 
document where you wish the text the Ask code will produce to appear and secondly 
define the entry for the field. 
 
To do this: 
1. First create your bookmark.   

2. Open your main document and place the cursor where you want the text to 
appear in the body of the letter.  Hold down Ctrl and press F9, this will produce { } 
this is an empty bookmark.  Type a name into these brackets, in the following 
example I have used {EveningDate}.   

3. Now, create the ask field start by placing the cursor above the body of the letter.  
It is a good idea to place the ask field near the top of the letter.  Click the Insert 
Word Field  button on the Mail Merge Toolbar and choose Ask, the following 
dialog box appears:  

 

4. Under the first box, Bookmark, type the name of the Bookmark you created in 
step 1.  In this example I have used EveningDate. 

5. In the prompt box type the prompt you want to appear on the screen when you 
run the merge. 

6. In the Default bookmark text box type any default text you want to appear.  In this 
example I have used the text “The first Monday of the month”.  If the user does 
not type any text into the Ask box “The first Monday of the month” will appear in 
the letter instead. 
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7. Tick the Ask once box if you want to be prompted for this information only once 
per merge.  If you leave this blank you will be asked for this information per letter. 

8. When you choose OK, Word displays the default text in a dialog box. 

9. Complete the Mail Merge as usual and the Ask dialog box will appear on the 
screen, type in the information you require in the Ask box and choose OK.  This 
information will now be included in every letter if you checked the Ask once check 
box.  

Fill-in or Ask? 
You may be wondering what the difference is between using the Fill-in field and the 
Ask field.  When using the Fill-in field the information is included only once in your 
letter and when you use the Ask field the information can go into your letter multiple 
times by inserting the Bookmark wherever you want it to appear.  

Working with field codes 
When you use an Ask field and Bookmark in a mail merge main document Word 
inserts fields into the document.  Word also uses fields to identify where the fields will 
be placed from your data source.  When working with Ask it can be useful to display 
these fields which are normally hidden.  To do this press Alt and F9 and Word will 
display the codes.  An example appears below.  Press Alt and F9 again will hide the 
codes.  
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Skip Record IF.. 
The Skip Record IF … field is useful if you want to use a criteria to send a letter to 
only some of the records in your data source. 
 
In the example below we are using the Salary field in the data source as criteria to 
decide whether or not the letter is created.  If the Salary field is less than or equal to 
25000 the record will be skipped.   
 
To use this field open your main document and then click the Insert Word Field  
button on the Mail merge toolbar and fill in the dialog box to meet your requirements.  
 

 
 

Includetext field 
Inserts the text and graphics contained in the named document. You can insert the 
entire document or a portion of the document. If the document is a Microsoft Word 
document, you can insert only the portion referred to by a bookmark.   
 
The following example inserts the portion of the file referred to by the Summary 
bookmark: 
 
{ INCLUDETEXT "C:\\My Documents\\Port Development.doc" Summary }. 
 

Nesting fields 
Many of these fields can be used together to obtain the desired result.  The following 
example will insert a file depending on the content of the “Type” field. 
 
{IF {MERGEFIELD Type} = “Hardware” “{INCLUDETEXT  "C:\\Exercise Files\\WORD 
Exercises\\hardware.doc"  \* MERGEFORMAT}” “{INCLUDETEXT  "C:\\Exercise 
Files\\WORD Exercises\\software.doc"  \* MERGEFORMAT}”} 
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Section 4:   Outlining 

 
 
Outline view is a view of the structure of a document.  It is very useful for any 
document which has headings and subheadings, for instance procedure manuals, 
minutes, structured reports, regulations, legal documents or training manuals. 
 
Outlining enables you to: 

·  reorganize your document quickly 

·  move around the document quickly 

·  promote or demote headings 

·  expand and collapse certain chapters or paragraphs 

·  assign numbers to headings that will automatically be updated after changes. 
 
You can create a highly structured document in outline view, or you can create the 
document in the normal way and use outline view to edit and format it.  Or you can 
create the headings in Outline, and then revert to normal view to add the body text. 
 
 

Viewing a Document in Outline 
 
To switch to Outline, select Outline from the View menu or choose the fourth button 
on the horizontal scrollbar. 

 
 

When you switch to Outline View Word does the following: 
 
·  Displays the outline bar in place of the ruler. 
 

 

·  Indents paragraphs to reflect their respective heading levels. 

·  Displays a selection symbol next to each heading and each paragraph 
 
 
Each paragraph has an icon, which tells you what level text it is. + or - means a 
heading and the further the icon is indented, the lower the level. 
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Notice that if you click once on an icon, all associated text (including lower level 
headings) is selected. 
 
 
 

Moving Through the Document Easily 
In a very long document, displaying headings allows you to check that all headings 
are typed in the same way i.e., upper and lowercase, would help you get to the place 

In outline view, text is 
either body text or one of 
9 heading levels 

The icon also tells you if 
there is subtext 
associated with the 
heading (+ means there 
is, - means there is not). 

The level of indenting is for information in 
outline view ; if you turn off outline view you 
will see there is less indenting. 

Show Level 

A small square 
means body text. 
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you wanted quickly and allow you to easily move large portions of text around.   You 
could even split the windows on a document, and have one window in outline view, 
and one in normal view.  You could then scroll through the outline to scroll through 
the normal view at the same time. 
 
Notice how you can tell if there is hidden body text under a heading: the icon is a 
plus, and there is a dotted line under the heading itself. 
 

Displaying different views in Outline 
To display only Heading 1 text Choose Level 1 in the Show Level  box on the 

Toolbar 
To display Headings 1 & 2 Choose Level 2 in the Show Level  box on the 

Toolbar 
To display all text Choose Show All Levels in the Show Level  box 

Expanding Text 
 
(When document is showing all headings and body text) 
 
1. Select a heading 

2. Press  on the ruler, or on the numeric keypad 

OR 

 Double click on the headings icon. 

Collapsing Text 
(When document is showing headings only) 
 
1. Select the heading 

2. Press  on the ruler or on the numeric keypad 

OR 

 Double click on the headings icon 
 

Promoting and Demoting Headings 
You must be careful when promoting or demoting headings.  You can end up 
promoting all text beneath the heading.  If the heading is collapsed, or if you click on 
a + selection symbol, Word includes all subtext in the selection and promotes or 
demotes the subtext with the heading.  If the heading is expanded, word promotes or 
demotes the heading and selected subheadings only.  Body text always travels with 
its corresponding heading. 
 
1. Select the text you want to demote or promote. 
 
2. Use the left and right arrows on the outline toolbar. 

To demote the heading and all its associated text: 

 
1. Click on the headings icon 
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2. Press the right hand arrow in the outline toolbar  
 
Choose normal view to see what effect this has had on the document. 
 
To promote the heading back to its original position, follow the same procedure with 
the left arrow instead. 
 

Demoting Heading Text to Body Text 
 
1. Select text 

2. Click the double right arrow on the outline toolbar  
 
Note: This gives you unindented normal text.   
 
To promote this text back to level 1, select it and click the promote arrow on the 
toolbar. 
 

Moving Text 
 
1. In outline view, select the text you want to move.  Remember, clicking the 

icon selects all associated subtext as well. 
 
2. Use the up and down arrows on the toolbar. 
 

 
 
The text will move below or above the next paragraph showing.  So if you want to 
change the order of a level 2 headings, it is much easier if you choose “show level 2” 
from the toolbar first. 
 

Printing an Outline 
 
When you print in outline view, Word prints only the headings and body text that 
appears on screen.  You can control the amount of detail printed by expanding and 
collapsing the outline.  The symbols will not appear in the printed document. 
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Section 5:   Master Documents 

 
It is sometimes difficult to deal with very large documents, i.e., a book or annual 
report.  It may take a considerable time to retrieve and save, moving around can be 
time consuming and confusing.  Therefore Word allows you to hold different sections 
of the same document in separate files and effectively merge them together in a 
Master Document  for printing, generating table of contents and indexes, search and 
replace functions etc.  These separate documents are referred to as subdocuments.   
An example of a subdocument might be a chapter of a book.  
 
You use the Master Document to retrieve the subdocuments into their proper 
locations in the master document.  Word will then generate all page numbering, 
footnotes etc, throughout the whole document. 
 

Creating a Master Document 
 
There are a number of ways to create a master document: 
 
·  Start from scratch by typing an outline in outline view 
·  Convert an existing long document into a master document 
·  Combine several Word documents to make a new master document 
 
Points Worthy of Note: 
 
·  Your Master Document should contain all formatting codes for the 

book/report. 
 

·  The maximum number of subdocuments allowed in a master document 
depends on the number of files you have open, the size of the files you have 
open, the number of programs you are running, the amount of computer 
memory, the operating system you are using, and other system 
configurations. If you reach this limit when you save the master document, 
Microsoft Word can't save your documents. 

 Creating Subdocuments 
 
1. Type an outline of all the headings in the document in Outline view.  To 

change to Outline view choose, Outline from the View menu. 

2. Decide on a heading level which will mark the beginning of each new 
subdocument i.e. heading 1.  You document should look something like this: 
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3. Select the headings you want to divide into subdocuments.  Make sure that 
the first heading in the selection is the heading level which will begin each 
new subdocument. 

4. Click on the Create Subdocument  button on the Master Document toolbar. 

 

 

5. Word creates the subdocuments as above. 

6. File, Save As  

7. Word saves the master document and all of its subdocuments in the location 
you specify.  Word automatically assigns filenames to the subdocuments. 

 

 
 
Note: The Master Document buttons are now available on the Outline toolbar.   
 
 Word sees each subdocument as another section. 
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Working with Subdocuments 
 
You can open, edit, format and print a subdocument, just as you would any other 
document.  You can open a subdocument within a master document view by double-
clicking the subdocument icon.  Word opens the subdocument in its own window. 
 

Converting an Existing Document into a Master Docum ent 
 
1. Open the existing document. 
 
Note: This option will only work if you have applied styles to your document. 

2. Switch into outline view. 

3. Decide on a heading level which will mark the beginning of each new 
subdocument i.e. heading 1. 

4. Select the headings you want to divide into subdocuments.  Make sure that 
the first heading in the selection is the heading level which will begin each 
new subdocument. 

5. Click on the Create Subdocument  button on the Outline toolbar.  

6. Each subdocument appears in it own box. 

7. Save the master document with all its subdocuments. 
 

Inserting an Existing Document into the Master Docu ment 
  

1. Open the Master document. 

2. Position the insertion point where you want to add the subdocument. 

3. Click the Insert subdocument  button on the Outline toolbar.  

4. Type the name of the file you want to add and choose OK 
 
 Word adds the document and keeps its original filename. 
 
Note: If the new document and the master document are based on different 

templates, or if they have different settings.  Word uses the formatting from 
the master document template, whilst you are within the master document.  
However, if you open the subdocument separately, it goes back to its own 
template. 
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Removing a Subdocument from the Master Document 
1. Open the Master document in Outline view 

2. Position the insertion point on the subdocument you wish to remove 

3. Click on the Remove Subdocument  button . 

Note: Removing a subdocument does not remove the text from the mast document.  
Instead it places the text directly in the mast document, rather than as a 
merged document. 

 
 

Page Numbering, Headers and Footers 
 
If you want page numbering, headers & footers to be the same and run through the 
whole master document, set the formats in the master document.  Do not set headers 
and footers or page numbering in any of the subdocuments. 
 

Table of Content, Index and Styles 
These should all be created in the master document.  Subdocuments will then 
conform to the master document. 
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Section 6:   Cross References 

A cross-reference refers to an item that appears in another location in a document—
 for example, "See Figure 1." You can create cross-references to headings, footnotes, 
bookmarks, captions, and numbered paragraphs. 

Create a cross-reference  
You can create a cross-reference only to an item that is in the same document as the 
cross-reference. To cross-reference an item in another document, you need to first 
combine the documents. The item you cross-reference, such as a heading or 
bookmark, must already exist. For example, you must insert a bookmark before you 
cross-reference it. 

1. In the document, type the introductory text that begins the cross-reference.  

For example, type For more information, see  

2. On the Insert  menu, point to Reference , and then click Cross-reference .  

 

3. In the Reference type  box, click the type of item you want to refer to— for 
example, a bookmark.  

4. In the Insert reference to  box, click the information you want inserted in the 
document— for example, the Page number, where the bookmark is located.  

5. In the For which  box, click the specific item you want to refer to— for 
example, the Bookmark.  

6. To allow users to jump to the referenced item, select the Insert as hyperlink  
check box.  

7. If the Include above/below  check box is available, you can select this check 
box to include information about the relative position of the referenced item.  

8. Click Insert .  

Note: Cross-references are inserted as fields.  If your cross-reference looks similar 
to {PAGEREF Roomrate \h}, Microsoft Word is displaying field codes instead 
of field results.  To see the field results, press ALT+F9, or right-click the field 
code, and then click Toggle Field Codes  on the shortcut menu. 
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Change a cross-reference  
Do one of the following: 

Change what a cross-reference refers to 

1. Select the cross-reference in the document (for example, "Figure 1"). Do not 
select the introductory text (for example, "For more information, see "). 

2. On the Insert  menu, point to Reference , and then click Cross-reference .  

3. In the Reference type  box, click the new item you want to refer to.  

Note: If you want to modify the introductory text in a cross-reference, just edit the 
text in the document. 

Update cross-references to page numbers 

Use this procedure if you move a cross-reference from one page to another. 

1. Select a cross-reference or cross-references to update. Do one of the 
following: 

·  To update a specific cross-reference, select it. 
·  To update all cross-references, select the entire document. 

2. Press the F9 key or right-click the selection, and then click Update Field  on 
the shortcut menu. 
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Section 7:   About footnotes and endnotes  

Footnotes and endnotes are used in printed documents to explain, comment on, or 
provide references for text in a document. You might use footnotes for detailed 
comments and endnotes for citation of sources.  In general a footnote appears at the 
bottom of the relevant page and endnotes appear at the end of document. 

Numbering 
The number of footnotes can be one scheme throughout the whole document or can 
restart at 1 for each section or page. 
 

�

Footnote and endnote reference marks 
Separator line 
Footnote text 
Endnote text 

A footnote or an endnote consists of two linked parts — the note reference mark and 
the corresponding note text. 

You can add note text of any length and format note text just as you would any other 
text. You can customise note separators, the lines that separate the document text 
from the note text. 

Insert a footnote or an endnote  

1. Click where you want to insert the note 
reference mark.  

2. On the Insert  menu, point to Reference , and 
then click Footnote .  

3. Click Footnotes or Endnotes.  

4. By default, Word places footnotes at the end 
of each page and endnotes at the end of the 
document. You can change the placement of 
footnotes and endnotes by making a selection 
in the Footnotes  or Endnotes  box. 

5. In the Number format  box, click the format 
you want.  

6. Click Insert .  



 

© Senan Solutions  Page 45 

7. Word inserts the note number and places the insertion point next to the note 
number. 

8. Type the note text.  

9. Scroll to your place in the document and continue typing.  

As you insert additional footnotes or endnotes in the document, Word automatically 
applies the correct number format. 

When you add, delete, or move notes that are automatically numbered, Word 
renumbers the footnote and endnote. 

 

Quick Keys 

ALT+ CONTROL+ F Inserts a footnote 
ALT+ CONTROL+ D Inserts an endnote 
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Section 8:   Templates 

 
Every document you create in Word is based on a Template.  A template is a 
document that is used as a “pattern” to create other documents.  Most office 
documents such as faxes, memoranda and the odd standard letter are ideal for 
templates.  A template can contain: 
 
Page Layout:   For example, margin settings, Print Layout settings, 

section information. 

Standard Text :   Text that is the same in every document.  For example, 
memo and fax headings, letter closings and standard 
paragraphs. 

AutoText Entries :   Graphics or Standard text used frequently in documents, 
such as addresses, standard paragraphs and logos 

Styles :   Styles are stored in a template.  Saving a style in a 
template means that when a specific type of formatting is 
required the style can be switched on. 

Macros :   A macro is a recording of repetitive keystrokes.  Macros 
are saved in templates. 

Menu, keyboard and 
toolbar assignments :   

The menu, keyboard and toolbars can all be customised.  
These customised settings are saved in a template. 

 
The template you use to create a new document becomes attached to that document. 
Whenever you open the document, Word opens or “loads” the template into memory 
to make customised items stored in the template available as you work.  Word opens 
the template “in the background” – that is you don’t see the template on your screen. 
 

The Normal Document Template 
 
NORMAL.DOT is a general-purpose template for any document.  Unless you select 
another template when you create a document, Word will base the document on the 
Normal Template. 
 
The Normal template is also where Word stores items that are “globally” available.  
Globally available items such as AutoText, Macros and Toolbars are available for 
every document, regardless of the template that the document is based on. 
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Template Storage 
 
Template files end with the extension .DOT, Word document files end with the 
extension .DOC. 
 
By default all templates are stored in the template folder. 
 
c:\documents and settings\username\application data \microsoft\templates 
 
However in a large organisation your templates may be stored on the network in your 
home area.  To check where your templates are stored check the File Locations  tab 
in the Tools , Options  dialog box. 
 

 
 
 
Two paths may be specified for template storage: 
 
User Templates Your Normal.dot is stored here and this 

area is personal to the User only.  Any 
templates you create will be saved here. 

Workgroup templates Shared Templates.  Normally shared by 
a department 
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Using a Template 
 
1. From the File  menu, choose New. 
 

The New Document  Task Pane will display 
 
 

2. To create a Blank document  (based on 
Normal) click blank document. 

3. To use a template you have recently used.  
Choose the template from the list. 

4. Alternatively to see a list of all the templates 
available to you choose the On my  
computer …..option 

 

 

 

 

 

 

 

 
5. Select the type of document you wish to produce from the tabs at the top of 

the dialog box. 
 
6. Select the template you wish to base the new document on. 
 
7. Choose the OK button.  
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Creating a Template 
 
Instead of setting up a document each time you use it you can create a template 
instead.  To create a template: 
 
1. Start a new Blank document. 
 
2. Format the document; check the paper size and margins in the Page Set-up 

dialog box.  Insert any text you want as standard text and create styles, 
macros and AutoText entries. 

 
3. From the File  menu, choose Save As .  

 

 
 

4. In the Save as type box change the type to Document Template (*.dot) 

5. This will automatically save the template in your template area. 

6. Type a name for the template and choose OK. 
 

Creating a Template from an Existing Document 
 
You may find that you have spent a lot of time creating and formatting a particular 
document.  If so, you may want to save a copy of the existing document as a 
template.  You can do this by using the File Save  As command. 
 
1. Open the document. 
 
2. From the File  menu choose Save As  
 
3. Choose “Document Template” in the Save as Type  box.   
 
4. Type a new name for the template and choose Save. 
 
5. Make any changes you want.  For example, delete any text that is not 

required.  Create and modify styles, AutoText entries and macros. 
 
6. Save and close the template. 
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Modifying a Template 
 
If you have a lot of changes to make to a template you can open it just as you would 
a normal document.  However you cannot simply double click on a template icon in 
explorer to open the template. 

1. From the File  menu choose Open 

2. In the Files of Type  box select Document Templates. 

3. Select the folder where the template is stored. 

4. Select the name of the template you wish to modify and choose Open.  

5. Edit and format the template as you would a Word document.  The Format Font  
and File Page Set-up  dialog boxes also have “Default” buttons that can be used 
to make changes to the attached template. 

6. Save and Close the template. 

Copying, Deleting and Renaming Template Items 
 
You can copy styles, toolbars, macros and AutoText entries from one template to 
another. 
 
1. From the Tools  menu choose Templates and Add-ins   
 
2. Choose the Organizer  button 
 
3. Select the tab for the items you want to copy. 
 

 
 
4. To copy items to or from a template or document, choose the Close  File 

button below the appropriate list.  Then Open File button and open the 
document or template. 

 
5. In the organizer dialog box, select the items you want to copy from either list 

and then choose the Copy  button. 
 
6. Choose the Close  button. 
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Using Fields to move the cursor about quickly when using a 
template 

If you create a template such as a Memo or Fax Cover Sheet you will want to move 
the cursor about quickly when you fill in the template.  When you are creating the 
template, place the cursor wherever you want to stop and type, then insert a field that 
will enable you to type and move to the next stop.  
 
When you are filling in the template, press F11 (Next Field), this keystroke moves you 
through the field codes one at a time.  If you accidentally go too far, pressing Shift 
F11 will move you backwards through the field codes.   

Creating Text form fields for filling-in 
If you are creating a template for others to fill in, Text form fields allow you to place a 
prompt in the field.  When a user presses F11 they move to a field with a prompt that 
tells them what to type at that position. 
 
To create a template using Text form fields: 
 
1. Create a new template, format it and insert any standard text. 
 
2. Save the Template 
 
3. Display the Forms toolbar.  Choose View, Toolbars, Forms  
 

 
 

4. Place your cursor at the location where variable text is to be typed. 

5. Click the first button on the 
toolbar.  This will insert a grey 
box, which is a Text Form Field. 

6. To insert a prompt for the user.  
Ensure that the cursor is still to 
the right of the Text Form Field 
and click the 4th button, which is 
the Form Field Options. 

7. Type the Prompt in the Default 
text box. 

8. Carry on inserting the fields into 
the template 
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Inserting Bookmarks 
Bookmarks mark a place in the document, which you can quickly go to.  Bookmarks 
in conjunction with macros enable you to determine where the cursor is placed  

1. Choose Bookmark  from the Insert  menu 

 

2. Type a meaningful name for the bookmark and click Add . 

Goto a Bookmark 

You can quickly move the cursor to a bookmark by using the Goto option: 
 

Edit, Goto Control+G F5 
 

 
 

Viewing Bookmarks 

You cannot normally see a bookmark.  When you are creating templates it is 
important to see where you have place a bookmark. 
 

1. Choose Tools, Options and then click the View tab 

2. Activate the Bookmark check box 

3. Now when you display your codes, Bookmarks will be displayed as a large I.  

Creating an AutoNew Macro 
To move the insertion point from one field to the next press the F11 key.  This means 
that each time you run the template, the first thing you need to do is to press F11.   
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Instead of performing the same keystrokes each time the template is used, the 
keystrokes can be recorded in a macro name AUTONEW. 
 
Naming a macro with the special filename AUTONEW means that the macro will 
automatically run when a new document is created, based on the template. 
 
To create the AutoNew macro: 
 
1. Make sure the template is in the active window. 
2. From the Tools  menu choose Macro, Record New Macro  

 

3. Type AutoNew  as the macro name. 
 
4. In the Store macro in : box change the setting to the template name you are 

creating. 
 
5. Choose Ok  
 
6. Press F11 to move the insertion point to the first Text Form field. 
 
7. From the Tools  menu choose Macro, Stop Recording  
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Section 9:   Forms 

The forms feature is used for creating and filling in on-line forms.  When you print 
forms you can choose either to print the complete document or just the fields that 
have been updated.  You would use this when you have pre-printed forms in the 
printer. 

Creating a Form 
Basic Steps: 
 
1. Create a template 

2. Design the form layout by inserting tables, gridlines or text 

3. Add form fields and define options such as formats or macros that run 
automatically 

4. Protect the template - If you do not protect the document the forms option will 
not work. 

5. Save the template 
 

Inserting Fields 
Display the forms toolbar 

 

1. Create a template form and save it. 

2. Position the insertion point where you want users to type or select variable 
information. 

3. Choose one of the following and then choose the Options button. 
 

Types of form fields 

  

A Text Form Field .   
Used for alpha characters such as addresses, descriptions, etc. 

  
A Check Box Form Field.    
Used for on/off or yes/no responses.  Insert label and check box. 

 

 

A Dropdown Form Field.    
Used for choice fields, creating dropdown lists. 
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Setting Options on a field 

  
Form Field Options.  Allows you to set formatting, size, default text, 
calculations, auto run macros, help text, etc, for all of the above field 
types. 

   
Protects and Unprotects all or sections of the form/document. 

 
 

Protecting the Document 
 
As you create the form it is difficult to imagine how it will actually run, because the 
dropdown arrows and check boxes do not become available until the document is 
protected.  At that point the cursor will only enter Form Fields and ignores the rest of 
the document entry and exit macros are activated. 
 
Note   When you follow these steps to add protection to a document, the form 

fields (form field: In a form, a location where a particular type of data, such as 
a name or address, is stored.) are reset. 

 

1. On the Tools  menu, click Protect Document .  

2. In the Protect Document  task pane, under Editing 
restrictions , select the Allow only this type of 
editing in the document  check box, and then click 
Filling in forms  in the list of editing restrictions.  

3. To add protection to only parts of a form, click 
Select sections , and then clear the check boxes for 
the sections you don't want to add protection to.  

Note   To add protection to only parts of a form, those 
parts must be in separate sections. (On the 
Insert  menu, click Break  to create section 
breaks.) 

4. Click Yes, Start Enforcing Protection.  

5. To assign a password to the form so that users who 
know the password can remove the protection and 
change the form, type a password in the Enter new 
password (optional) box, and then confirm the 
password. Users who don't know the password can 
still enter information in the form fields.  

6. Save the Template. 
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Filling In an Online Form 

1. File, New  Choose the Form Template 

2. The pointer automatically goes to the first field 

3. Enter the data required and TAB or ENTER or CURSOR to next field 

4. SHIFT+TAB or UP ARROW moves to previous field. 

5. File, Save As  

6. Name the file and choose OK 

Saving Online Form Data Only 
You can save only data in a text file, which will save space on the disk. 

1. Tools, Options  

2. Select the Save tab 

3. Select the Save Data Only for Forms  check box 

4. Choose OK 
 

Printing Forms 
 
You can print forms exactly as you would normal documents.  This will print both the 
form and the data or you can choose to print the form data only - perhaps on to pre-
printed forms. 

1. Tools, Options  

2. Select the Print  tab 

3. Under Options for Current Document Only , select Print Data Only For 
Forms  check box. 

4. Choose OK 

Editing a Form 
Before you can edit a Form you must first remove the protection.   

Remove protection from a form  

1. Do one of the following:  

·  On the Tools  menu, click Unprotect Document .  

·  On the Forms  toolbar, click Protect Form . 

2. If the form requires a password, type the password. 

If the form contained data, Microsoft Word preserves the data when you protect the 

form again. You can clear the data by clicking Reset Form Fields  on the Forms  
toolbar.  
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Note: When you are designing or changing a form, you can quickly protect the form 

or remove protection from it by clicking Protect Form  on the Forms  
toolbar. 
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Section 10:   Basic Macros 

 
A macro is a series of frequently used keystrokes stored in a file that you can later 
replay by issuing only one command.  The stored keystrokes can consist of text, 
commands or a combination of both. 
 
Although the macro language and its features are very powerful, macros are easy to 
use.  The macro feature is extremely flexible and there are a number of options 
available to you at each stage of the operation. 
 

Creating Macros 
If you regularly type a specific kind of document that requires unique format settings, 
and perhaps standard text, or there are particular tab settings that you frequently set 
up for a number of documents, you can design a macro that produces all the format 
commands and text. 
 
The easiest way to start a macro is to record it.  This is like turning on a key and then 
every single keystroke you type Word remembers and stores it in a file to be replayed 
as and when needed. 
 
Note:  Macro Record will record typing, commands and operations to build the 

macro.   
 
The procedure to create a Macro is as follows 
 
1. Choose Tools, Macro, Record new macro  
 
2. Name the Macro 
 
3. Select  Template Availability 
 
4. Assign to a Toolbar or Keystrokes 
 
5. Describe the Macro 
 
6. Choose OK 
 
7. Record the Keystrokes 
 
8. Turn off Stop Recorder (Button)  
 
Tip: A particularly good Macro to record is one tha t will print current page 

only, instead of having to go all the way through F ile, Print, Current 
Page, OK 
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Recording a Macro 
 
To start recording you can simply Double-click “REC” on the status bar 
 
or................ 
 
1. Choose Tools, Macro, Record New macro  
 
2. Type a name for the macro 
 

 
 
3. Select where the macro will be stored 
 
 All Active Templates  Macro will run with all the open templates 
 Normal.Dot  Macro will run with all templates in future - not 

only the current open ones. 
 ?.DOT Will only run with the template you are currently 

using. 
 
4. You can type a description of what the macro does, for future reference. 
 

5. Choose OK.  The stop recording toolbar should appear on the screen.  

 
 
6. Perform the keystrokes or mouse actions you want the macro to record.  

When you have finished, either click the Stop button on the toolbar, or 
choose the Tools  menu and choose Macro  and choose Stop Recording .   
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Assigning a Macro to a Toolbar 
 
When you are recording a macro you are given the chance to assign the macro to a 
toolbar button or keystroke.  Sometimes it is easier to do this after you have recorded 
the macro.  To assign the macro to a toolbar after you have finished recording: 
 
1. Right click on any toolbar button and choose Customise , or from the View 

menu choose Toolbars  and choose Customise .   
 

 
 

2. Select the Commands  tab and choose the Macro Category. 
 

 
 

3. Click on the macro name and drag on to a toolbar, release the mouse button. 
 
4. The macro will have a name as well as a picture on the button.   
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To change the button just to a picture, click on the button and then choose the 
Modify Selection  button in the dialog box.  From the menu that pops up choose 
Default Style .  If you now want to change the picture choose Modify Selection  again 
and then choose Change Button Image  and choose the image you want.  Choose 
Close to return to your document. 

Assigning a Macro to the Keyboard 
 
1. Right click on any toolbar button and choose Customise , or from the View 

menu choose Toolbars  and choose Customise  

2. Choose the Keyboard  button 
 
3. In the Categories box choose Macros 
 
4. Select the macro you wish to assign to a shortcut key 
 
5. Click in the Press  New Shortcut Keys  - Hold down various key 

combinations, i.e. Alt+Control+D - If the keystrokes are already assigned 
Word will display the operation. 

 
 

 

6. Choose Assign and close to return to your document. 
 
 

Pausing and Resuming whilst Recording 
 
The 2 buttons that appear on the screen whilst you are recording are for stopping and 
pausing the macro during creation. 
 
1. To pause, click the Pause button on the Macro Record Toolbar 
 
2. Perform the actions you do not want to record 
 
3. To resume recording, click the Pause button again 
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Running a Macro 

Using the Tools Menu: 

1. Choose Tools, Macro  
 
2. Select the macro you want to run and then choose Run 

Deleting a Macro 
The following will only delete a global macro or a macro in the active template.  To 
delete the macro stored in an unopened template, use the Organizer. 
 
1. Choose Tools, Macro, Macros  
 
2. Select or type the name of the macro you wish to remove. 
 
3. Choose Delete and Close . 
 
4. If the macro is assigned to a toolbar, it will automatically be removed. 

Copying a Macro to another Document 
 
1. Choose Templates and Add-ins  from the Tools  menu  
 
2. Click on the Organizer  button. 
 
3. Click the Macro Project Items  tab 
 
4. In the Macro Project Items Available In  box on the left-hand side, select the 

template that contains the macro you want to copy. 
 
5. In the Macros Project Items Available In  box on the right-hand side, select 

the template to which you want to copy. 
 
6. Select the macro and choose the Copy  button 
 
7. Choose Close  
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Auto Macros 
 
Word recognises a macro whose name begins with “Auto” as a macro that runs 
automatically when the situation it applies to arises.  You create the macro in the 
normal way, but it is the macro’s name that determines whether it will run 
automatically or not.  You obviously don’t need to assign these macros to keystrokes 
or menus. 
 
There are three main Auto macros: 

AutoNew 

 AutoNew might run after you create a new document.  It could be used to 
move to the first field in a document or to unlink date fields. 

AutoOpen 

 The AutoOpen macro might run after you open a file with File Open, File Find 
or the list of documents at the bottom of the File Menu. 

AutoExec 

 The AutoExec macro might run when you start Word.  This macro makes it 
easy to set up Word so that every time you start it, you don’t have to make 
additional adjustments before proceeding with your normal work; i.e. 
defaulting to the correct directory, or always opening the last document used. 
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Section 11:   Sorting 

 
 
Word gives you the option of sorting alphabetically, numerically or by date, and in 
ascending or descending order.  You can sort whole paragraphs, lines, items in a list 
or columns within a table/tabulation.  When sorting Word sees the columns in a 
tabulation as field 1,2,3 etc... 
 
Note:  You should always save your document before sorting.  You can undo 

sorting, but by saving first you provide extra backup, if the sort command 
does not produce the desired results. 

 
Plus: You must select text to sort otherwise Word assumes you wish to sort the 

whole document. 

Sorting a Table 
 
By far the easiest way to sort is to type your information into a table.  Only type one 
piece of information per cell.  For example, to type Mr. Peter Bloggs, use three 
columns.  The first row of the table should be a header row that describes what 
information is in each column.  To make a row a header row, select the row and then 
choose Heading Rows Repeat  from the table menu.  For example: 
 
Title First Last Department 
Mr Peter Bloggs Training 
Mrs Sally Smith Sales 
Mrs Ann Bloggs Marketing 
Mr Fred May Sales 
 
 
To sort a table, click anywhere within the table and then choose Sort  from the Table 
menu.  If you are sorting names you will want to sort first by last name, and then by 
first name, to make sure that people with the same last name are sorted 
alphabetically. 
 

 
 

Title First Last Department 
Mrs Ann Bloggs Marketing 
Mr Peter Bloggs Training 
Mr Fred May Sales 
Mrs Sally Smith Sales 
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Sorting Tabulated Columns 
You can also sort information that has been typed using tabs.  To sort tabulated 
columns: 

1. Select the text or column you want to sort. 
 
2. Choose Table, Sort  

 

3. Adjust the options as necessary 

 Uppercase letters will precede lowercase, unless ‘case sensitive’ is turned 
off. 

4. Choose OK. 
 
Note: If the list has a heading you don’t want sorted, Activate the Header Row 

option   
 
 If you want to sort by the second or third word of a phrase, define a space as 

the field separator and then select Field 2 or Field 3 as the first sort key. 
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Sorting by a Field or Column (.csv file) 
If you need to sort an ASCII file or delimited file i.e., commas separate the fields 
rather than tabs or a table layout, you can specify which fields to sort by. 
 
A .csv file would look like this: 
 
Title, First, Last, Department¶ 
Mr, Peter, Bloggs, Training¶ 
Mrs, Sally, Smith, Sales¶ 
Mrs, Ann, Bloggs, Marketing¶ 
Mr, Fred, May, Sales¶ 
 
The comma separates the fields and the paragraph mark indicates the start of a new 
record.  Each record appears on a separate line, and each line contains linked 
information (fields) which must be kept together.  If you sort by one field (e.g. 
department), you want the rest of the line to move also.  Therefore you must select 
the whole tabulation, to ensure that the records stay intact.  Word allows you to 
specify a field as a key for the sort. 
 
1. Select the text you want to sort. 
 
2. Choose Table, Sort.  
 
3. Move to Sort By  and choose the column/field you want to use as a key to 

sort the selection. 
  
Each item between commas or tabs is a field.  The default is a paragraph 
sort.   

 
4. In the Type box, select the type of information to be sorted, text, number or 

date. 
 
5. Through the Options  button check the correct field separator is selected 

(comma or tab ).  Adjust other options as required. 
 

 
 

6. Choose OK 
 
Note:  If you add borders to cells and then sort the cells, the borders stay with them.  

As a result, sorting a table may change its borders. 
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Section 12:   Tracking & Reviewing Documents in Wor d  

Prepare a document for review 
With Microsoft Word, you have several options for sending a document to review and 
for tracking, incorporating, and keeping a record of changes made. 
 
If you have a document that you want reviewed by your team and you want final 
control over which changes to accept or reject, you can prepare copies of a document 
and distribute the copies to others for electronic review and markup. 

Tracking Changes 
Word uses revision marks to track changes so that after the document is reviewed, 
you can see the changes and comments made by each reviewer. You can merge 
each reviewer's comments and changes into the original document so that you can 
review and accept or reject each change. You can send a copy to each team member 
simultaneously or route a single document so that each reviewer sees the previous 
reviewers' changes and comments. 
 
If you are not using the routing system the document must be saved in a shared 
folder so that other team members can open the document and edit it. 
 
1 Open the document you want to prepare for review. 
 
2 Check whether the document contains 

multiple versions by clicking Versions on the 
File menu. If multiple versions exist, save the 
current version as a separate document with 
a different name, and use this copy as the 
review copy. Otherwise, reviewers can open 
and view previous versions of the document. 

 
3 On the Tools  menu, click Protect  

Document . 
 
4 Activate Editing restrictions  

5 To let others change the document and insert 
comments and to track all changes with 
revision marks, make sure Tracked 
Changes  is selected. To let others insert only 
comments and not change the contents of 
the document, click Comments .  

 
6 Click the Yes, Start Enforcing Protection . 

Button.   
 
7 To let only authorised reviewers add changes 

and comments, type a password. 
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Note: If a document is not protected with a password, anyone can unprotect the 

document (by clicking Unprotect Document on the Tools menu) and then 
make changes that will not be tracked. 

 

Select parts of a document and allow certain users to edit 
 
1 On the Tools  menu, click Protect  Document . 
 
2 Activate Editing restrictions 
 

The task pane will display another section 
headed Exceptions (optional ) 
 

3 Select parts of the document that you wish users 
to edit. 

 
4 Choose the Users who are allows to edit, either 

by placing a tick in the Everyone box or by 
Clicking on More users…..and selecting users 
from the network 
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Editing a Tracked document 
 
When tracking is turned on TRK appears in the status bar.  This means that any 
changes made will simply be marked so that the originated can review them at a later 
date.   
 

 
 

·  When text is inserted it appears in another colour and is underlined. 
 

·  When text is deleted it is removed from the body of the text and placed in a 
balloon on the right of the screen 

 

Make the changes you want by inserting, deleting, or moving text or graphics.  Insert 
comments and highlight relevant text. You can also change any formatting. Microsoft 
Word uses revision marks to show the tracked changes.  

 

Display the Reviewing Toolbar 

View, Toolbars, Reviewing: 

 

Inserting a Comment 
1. Select the text or item you want to comment on, or click at the end of the text. 

2. On the Reviewing  toolbar, click Insert Comment  . 

3. Type the comment text in the balloon to the right of the screen.  

 

Highlight important text 

1. On the Reviewing  toolbar, click Highlight . 

2. Select the text or graphic you want to highlight. 

3. Select the next item in the document that you want to highlight.  

4. To turn off highlighting, click Highlight   again, or press ESC.  
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·  To change the highlighter colour, click the arrow next to Highlight , 
click the colour you want, and then select the text or graphic you want to 
highlight. 

·  You can display or hide highlighting (but not the text itself) on the screen and 
in the printed document by clicking Options  (Tools  menu), and then 
selecting or clearing the Highlight  check box on the View tab.  

 

Accept or reject changes made with revision marks 
 
You can review tracked changes by using the Reviewing toolbar .   First make sure 
changes are highlighted on the screen. If the ScreenTips option is turned on, you can 
see who made each change by resting the pointer over the highlighted revision. 
 
·  If revision marks don't appear in the document, ensure that 

 is selected in the Display for Review  box on the 
Reviewing toolbar. 

 
·  If the reviewer information doesn't appear above the change when you rest the 

pointer over it, click Options on the Tools menu, click the View tab, and then 
select the ScreenTips check box. 

 

Reviewing Toolbar 

   Previous Change 
Moves to the previous change of text or formatting in the 
document 

 Next Change 

Moves to the next change of text or formatting in the 
document 

 Accept Change 

Click this button to  

·  Accept the highlighted change 

·  Accept all changes shown 

·  Accept all changes in the document 

 Reject Change 
Click this button to  

Reject the highlighted change/delete comment 

Reject all changes shown/delete comments shown 

Reject all changes/ delete comments in the document 

   Turns on Tracking 
Any changes made to the document will be marked.  
Using the Reviewing toolbar does not protect the 
document.  

Reviewing Pane 

Splits the screen in half and displays the Reviewing 
pane at the bottom of the screen, so you can read all 
comments, insertions and deletions in one place. 

Accept or reject all changes in one pass 
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Click the dropdown arrow next to Accept Change and select Accept all changes in the 
document.  If you change your mind, you can click Undo . 
 

To see how the document would look if you accepted all changes: 

 

Choose the Final option from the dropdown list 
 
You must remember that the revision marks are still  hidden underneath.  You 
have purely chosen not to view them.  If you email this document the revision 
marks will be displayed automatically. 
 
You must Accept or Reject the changes to clear revi sion marking. 

To see how the document would look if you rejected all changes 

 

Choose the Original  option from the dropdown list 
 
However, if the document contains formatting changes, Word displays the changed 
formatting, not the original formatting. 
 
Note: If you've used the Versions command on the File menu to save multiple 

versions of the document in one file and you want to compare the current 
version with an earlier one, then you must first save the earlier version as a 
separate file under a different name. 
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Change the formatting Word uses to mark tracked cha nges 
 
You can change the way revision marks look and work in a document by clicking the 

dropdown arrow next to  and selecting Options.  Then completing one or 
more of the following options. 
 
 

Insertions Sets the format used to mark inserted text. 
Deletions Sets the format used to mark deleted text. 
Formatting Sets the format used to denote formatting changes. 
Changed lines Sets the location of the vertical lines that mark changed 

paragraphs. 
Colour Sets the colour applied to insertions, deletions, formatting 

changes, and changed lines. By default, Word uses a 
different colour for each reviewer. The default setting for 
all options except Changed lines is By author. 

Comments colour Sets the colour applied to any comments that you insert in 
a document. 

Use balloons  

(Print and Web Layout) 

Specifies when to display comments and tracked changes 
in balloons located in the margins of your document. 
Selecting Never places comments and tracked changes in 
the text of your document. Select Never to use tracked 
changes in documents created with Word 2000 and earlier. 

Preferred width Sets the desired balloon width. 
Margin  Specifies the margin in which Word displays balloons. 
Measure in Sets the unit of measurement for balloon widths. 
Show lines connecting with 
text 

Displays a line connecting each balloon to the location of 
each change or comment in the document. 

Printing (with Balloons)  

Paper orientation Sets the paper orientation when you print a document and 
its tracked changes or comments. Click Auto to let Word 
determine the best orientation. Click Preserve to keep the 
orientation specified in the Page Setup dialog box. Click 
Force Landscape to allow the most room for your 
balloons. 
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Displaying tracked changes and comments  

You can view all markup changes in your document, 
or you can limit the kind of change that's displayed. 

For example, you can use the  menu to hide 
formatting changes and comments so that you can 
concentrate on insertions and deletions. Or, you can 
display comments and changes for a specific 
reviewer. 

 

 

 

 
Note: If you hide a type of markup by clearing it on the Show  menu, the markup 

automatically appears each time the document is opened unless you clear 
the Make hidden markup visible when opening or saving  check box on 
the Security  tab of the Options  dialog box (Tools  menu). Even if you clear 
this check box, the markup is still in the document and can be revealed by 
selecting the type of markup on the Show  menu.  
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Section 13:   Sending a Document for Review. 

 
There are two ways to send a document for review: 
 
 File, Send to, Mail Recipient (for Review) 

Use this if you are sending the document internally, within the company using 
the Network Server. 
 
File, Send to, Routing recipient 
Use this if you are routing the document via e-mail – externally and/or 
internally, or if you are not connected to a Network. 

Sending a file for review (using the Network Server /shared folder) 
You can use the Mail Recipient (for Review)  command to send a file for others to 
review. When you send a file for review, a review request form is created 
automatically with the following: 

·  A link, an attachment, or both a link and an attachment to the file.  

·  A follow up flag .  
·  Message text for the reviewer. This text will vary depending on the location of 

the file.  

When a reviewer receives the file, the reviewing tools are enabled and displayed. The 
files returned from reviewers automatically prompt you to merge changes. You can 
then use the reviewing tools to accept or reject the changes. Once you've received all 
feedback from the reviewers, or once you decide to stop accepting feedback, you can 
choose to end the review cycle. 

Understanding links and attachments 
How a file is included in a review request will vary depending on the location of the 
file to be reviewed. 

On your computer only 

The file is automatically attached to the review request. If you want to create a shared 
location for the file at the time you send the file for review, use the Attachment 
Options  task pane in Outlook.  

In a shared location such as a network server 

The review request contains a link to the shared location, and you have the option to 
include the file as an attachment. If some reviewers do not have access to the shared 
location, you will want to attach the file. 

On a Web discussion server 

The review request includes a link to the document discussion and includes 
instructions on how to use a discussion server.    You have the option to include the 
file as an attachment. If some reviewers do not have access to the shared location, 
you will want to attach the file. 
 

Create a routing slip and start routing a document 
If you want others to review a document, you can route the document via e-mail. 
First, create a routing slip that specifies how to send and track the document. For 
example, you can send the document to each recipient in turn, so that each recipient 
can view all previous comments. Or send a copy of the document to each recipient 
simultaneously. Once you've created the routing slip, you can save it with the 
document, or route the document right away. 
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1. Open or create the document that you want to route. 

2. On the File  menu, point to Send To , and then click Routing Recipient . 

3. To select the recipients to route the document to, click Address . 

 
 

4. In the Type name or select from list  box, type a recipient's name, and then 
click To. Once you've entered the last recipient name in the To box, click OK.  

·  If you select a Personal Distribution List  as the recipient, Microsoft Word 
will route a copy of the document to all members of the distribution list 
simultaneously. To route the document to the members of the distribution list 
sequentially, select individual member names instead.  

 
·  You can change the order in which recipients will receive the routed 

document by changing the order of recipient names in the list. Select the 
name of the recipient you want to move up or down in the list, and then click 
the appropriate arrow.  

5. Select any other routing options you want.  

6. Do one of the following:  

·  To route the document right away, click Route . 

·  To route the document later, click Add Slip . When you’re ready to route the 
document, open it, point to Send To  on the File  menu, and then click Next 
Routing Recipient .  

 
Note When you route a document, the document is sent in Word format (.doc) as 

an attachment to an e-mail message. 

 

Edit a routing slip 
1. Open the document with the routing slip that you want to edit. 
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2. On the File  menu, point to Send To , and then click Other Routing 
Recipient . 

3. Do one of the following:  

·  If you're the originator of a routed document, change the routing slip options 
that you want. 

·  If you're the recipient of a routed document, you can change the order in 
which other recipients see the document. Select the recipient name whose 
order of receipt you want to change, and then click the appropriate move 
arrow.  

Review the routed document    After you route a document, each recipient can 
review the routed document, and you can track its status. When all recipients have 
reviewed the document, it is automatically returned to you. 

Receiving your original back 
When the document has completed its routing it will automatically be returned to you.  
When you open the document in your Inbox you will be asked if you wish to merge 
the received document with your original document. 
 
You should agree to merge so that you can review, accept or reject the changes. 
 
If you do not agree to the merge you will not be able to turn off Tracking and as such 
will not be able to accept or reject changes. 
 
See Compare and Merge 2 documents on page 78. 
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Section 14:   Receiving and Editing a Routed Docume nt 

 
A routed document is an attachment in an e-mail message. To open a routed 
document, follow the instructions for your e-mail program. If you're using Microsoft 
Exchange, double-click the document icon to open the routed document. 
 
A routed document has tracking turned on this means that any changes you make will 
simply be marked so that the originated can review them at a later date.   
 

Make the changes you want by inserting, deleting, or moving text or graphics.  Insert 
comments and highlight relevant text. You can also change any formatting. Microsoft 
Word uses revision marks to show the tracked changes.  

 
Note: If you wish to keep a copy of the revised document Save it in your own area.  

Alternatively you can simply route it to the next routing recipient 
 

Routing to the Next Recipient 
 
1 Open the document you want to route. 

2 To route the document to the next person on the routing list, point to Send To  
on the File  menu, and then click Next Routing Recipient .  

 

 

3 Activate Route document to recipient name  click OK. 
 
Note: To route the document to a person who is not on the routing list, point to 

Send To on the File  menu, and then click Other Routing Recipient . 
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Section 15:   Compare and Merge 2 Copies of a Docum ent 

 
When a document has completed its routing it is returned to the Originator who will 
then review the tracked changes.  The Originator has the original document and the 
returned e-mail document, which is a copy of the original with changes by different 
people. 
 
The Originator now needs to merge the 2 documents to review the changes. 
 
1 Open the edited copy of the document – normally an e-mail attachment. 

2 On the Tools  menu, point to Compare and Merge Documents.  
 
3. Locate and click the name of the original document, or type its name in the 

File name box. 

 
4 Click on the dropdown arrow next to the Merge button and choose one of the 

following: 

Merge 

Changes to the document that is already open are shown as tracked changes 
in the document you selected in the Compare and Merge Documents  dialog 
box. 

Merge into current document 

Changes to the document you selected in the Compare and Merge 
Documents  dialog box are shown as tracked changes in the document that 
is already open. 

Merge into new document 

Changes in both documents are merged into a new, third document, with 
differences shown as tracked changes. 

Compare with Legal blackline option 

When you use the Legal blackline  option, Word displays a new, third document in 
which tracked changes in the baseline document are accepted and changes in the 
selected document are shown as tracked changes. The documents being compared 
are not changed. 
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Note  If you want to compare changes from a number of reviewers, do not select 
this option. Use one of the merge commands instead. 

 

5 Accept or reject the changes as detailed above. 
 
 

Comparing documents side by side 
 
Sometimes viewing multiple users’ changes in one document can be overwhelming, 
but now you can use a new approach to compare documents. Comparing documents 
side by side allows you to determine the differences between two documents without 
having to merge multiple users’ changes into one document. You can scroll through 
both documents at the same time to identify differences between the two documents.  
 
1. Open the two document you wish to compare. 
 
2. From the Window  menu choose Compare Side by Side  with …. 
 

 
 
3. Select the document you wish to compare and choose OK. 
 
4. The screen will display both documents on screen side by side.  The 

following toolbar will appear to enable you to scroll through both documents 
at the same time. 
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Section 16:   Versions 

 
If you have a document that may be revised in the future by you or others, you can 
set up the document so that Word saves a "snapshot" of the current version 
automatically each time you or another reviewer closes the document after making 
changes. All versions are stored within one document, although Word displays only 
the current version by default. For each version in the document, Word records the 
date and time the version was saved and the name of the person making the 
changes. You can view any one of the previous versions in a separate window by 
opening that version from the Versions dialog box. 

Automatically save a version on close 
When you turn this option on the file will automatically create a version when it is 
closed by a user.  The date, time and user is logged.  The user does not realise that a 
version is being created. 
 
1. On the File  menu, click Versions . 

2. Select the Automatically save a version on close  check box. 
 

 

3. Click Close .  
 
If versions are turned on in a document the following icon will appear in the status bar 
at the bottom of the screen. 

 
 

Manually Saving a version as required. 
The above option automatically saves a version of the file when it is closed.  However 
the file can become very large.  Another option is to only save as a version when 
required.  To sve a version of the document: 
 
1. Choose File, Versions  
 

Click here to automatically save a 
Version when the file is closed.  
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2. Type a comment to remind you what this version contains and click OK. 
 

 

Save a version of a document as a separate file 
 
1 On the File  menu, click Versions  ( double click the versions icon on the 
status bar). 
 
2 Highlight the version of the document you want to save as a separate file. 
 

 
 
3 Click Open. 
 

Click here to Save a version of 
the current document 
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When you open a version of the document Word will display both versions on 
the screen at the same time and split the window horizontally. 

 
4 On the File  menu, click Save As . 
 
5 In the File name box, enter a name, and then click Save 
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Section 17:   Customising the Toolbars and Menus 

You can customise the existing toolbars and menus in Word or you can make new 
toolbars.  At any time you can reset the toolbars and menus back to the standard 
settings. 

Editing the Toolbars 
 
To edit the toolbars: 
 
1 Choose the Tools  menu and then choose Customise , or right click on any 

toolbar button and choose Customise .  The customise dialog box appears: 

 

2 To remove a button from a toolbar, take the mouse up to the toolbar button 
and drag it off of the toolbar. 

3 To add a button, change to the Commands  tab at the top of the dialog box. 
The category section down the left-hand side lists the names of the menus 
that the commands appear on.  

 
For example, if you wish to add a command from the Edit menu, choose the 
Edit category.  Once you have chosen the category the commands for that 
category are listed in the commands section on the right.   

 
4 To add a new command/button to the toolbar, click on the button and drag it 

up to the toolbar. 

5 To move a button on the toolbar, click on the button and drag it to a new 
position. 

6 To reset the toolbars back to the standard setting, click on the Toolbars  tab 
at the top of the dialog box, click to choose the toolbar you want to Reset and 
then click the Reset  button. 
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7 To change the picture for a toolbar button, click 
on the button you wish to change and then 
choose the Modify Selection  button the menu 
on the right appears: 

8 Choose Edit Button Image  if you wish to draw 
a picture yourself or choose Change Button 
Image if you want to choose from the gallery of 
button pictures available.   

9 Choose Close  when you have finished editing 
your Toolbars.   

 

Create a New Toolbar 
 
To make a new toolbar: 
 
1. Choose Tools  menu and then choose Customise or right click on any 

toolbar button and choose Customise .  The customise dialog box appears: 

2. In the Toolbars  tab of the dialog box click the New button and type in a 
name for the toolbar and choose OK. 

3. The toolbar appears on the screen.  Be careful as it is easy to miss as it is 
very small to start with. 

4. When you have located the toolbar change to the Commands  tab at the top 
of the dialog box and drag the buttons you want onto your new toolbar.   

5. Choose Close  when you have finished creating your new toolbar. 

6. Switch the new toolbar on and off in the normal way by choosing the view 
menu and then clicking on the toolbar name.   

Add a custom menu to a toolbar or the Menu Bar 

1. Show the toolbar you want to add a custom menu to. 

2. On the Tools  menu, click Customise , and then click the Commands  tab. 

3. In the Categories  box, click New Menu. 

4. Drag New Menu from the Commands box to the displayed toolbar or to the 
menu bar. 

5. Choose the Modify Selection  button and then type a new name for the 
menu and Press ENTER. 

6. To add a command to the custom menu, click the new custom menu on the 
toolbar to display an empty box. Click the category for the command in the 
Categories box, and then drag the command from the Commands box to the 
empty box in the custom menu. 
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7. Choose Close when you have finished adding commands. 

The Menu Bar 
 
The menu bar at the top of the Word window is just another toolbar called the Menu 
Bar.  When you are in the customise dialog box you can drag commands off of the 
menu bar and add new commands to it.  At any point you can reset this menu bar by 
choosing it in the Toolbars tab of the Customise dialog box and choosing Reset .  

 
  

Assigning Macros to Menus and Toolbars 
 
Having recorded a macro, it is a simple matter to allow the macro to be run either by 
selecting a menu item or placing the macro on a button. 
 

Assigning a Macro to a Toolbar Button 
 
To assign a macro to a toolbar it is best to have already recorded the macro. Having 
done this go through the normal procedure to customise the toolbars, follow the 
instructions below to do this 

1. Choose Customise  from the Tools  menu or click the right mouse button over an 
existing toolbar and from the shortcut menu choose Customise . 

2. From the Customise  dialog box, choose the Commands  tab.  Scroll down the 
list of categories until you get to the Macros group. 

Menu bar 
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3. Find the macro you want from the right hand side of the dialog box and drag the 
macro up to the required toolbar.  The name of the macro will be far too long.  

4. To change the name to a picture, click the Customise Selection  button and then 
choose Default Style .  The name now changes to a picture.  To choose a 
different picture choose Customise Selection  again and then choose Change 
Button Image  choose the image you require and choose Close  to return to your 
document.   

5. To play the macro now, just click on your new button.   

Adding a Macro to a Menu 

1 Make sure the toolbar you want to add a custom menu is showing on the 
screen. 

2 On the Tools  menu, click Customise , and then click the Commands  tab. 

3 In the Categories  box click New Menu. 

4 Drag New Menu from the Commands box to the displayed toolbar or to the 
menu bar. 

5 Choose the Modify Selection button and then type a new name for the 
menu and Press ENTER. 

6 From the Customise  dialog box, choose the Commands  tab.  Scroll down 
the list of categories until you get to the Macros group. 

 
7 Find the macro you want from the right hand side of the dialog box and drag 

the macro up to the new menu.  The name of the macro will be far too long.  

8 Choose the Modify Selection  button and type in a new name in the name 
section at the top of the menu. 

9 Choose Close to return to your document. 
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Section 18:   Keyboard Shortcuts  

 
Ctrl A Selects All the document 

Ctrl B Switches bold  on/off 

Ctrl C Copies selected text 

Ctrl D Opens Font dialog box 

Ctrl E Centre alignment 

Ctrl F Find 

Ctrl G Go to 

Ctrl H Replace 

Ctrl I Switches italic on/off 

Ctrl J Full Justify 

Ctrl K Autoformat 

Ctrl L Left alignment 

Ctrl M Increase paragraph indent 

Ctrl N New document window 

Ctrl O File Open 

Ctrl P File Print 

Ctrl Q Removes paragraph formatting and resets to style 

Ctrl R Right Justify 

Ctrl S Save 

Ctrl T Hanging indent 

Ctrl U Switches underline on/off 

Ctrl V Paste 

Ctrl W Closes document window. 

Ctrl X Cut selected text 

Ctrl Y Repeat Typing 

Ctrl Z Undo 
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Keys for formatting characters and paragraphs 
To Press 
Change the case of letters SHIFT+F3 
Apply bold formatting CTRL+B 
Apply underline CTRL+U 
Underline words but not spaces CTRL+SHIFT+W 
Double-underline text CTRL+SHIFT+D 
Apply Italic formatting CTRL+I 
Remove manual character formatting CTRL+SPACEBAR 
 
 
Moving & Copying 
To Press 
Copy a Selection CTRL+C 
Cut a Selection CTRL+X 
Paste a Selection CTRL+V 
Copy formats CTRL+SHIFT+C 
Paste formats CTRL+SHIFT+V 
 
Format paragraphs, when setting line spacing 
To Press 
Single-space lines Ctrl+1 
Double-space lines Ctrl+2 
Set 1.5 space lines Ctrl+5 
Add or remove one line of space preceding a 
paragraph.  

Ctrl +0 (zero) 

 
 
When setting paragraph alignments and indents 
To Press 
Centre a paragraph CTRL+E 
Justify a paragraph CTRL+J 
Left align a paragraph CTRL+L 
Right align a paragraph CTRL+R 
Indent a paragraph from the left CTRL+M 
Remove a left paragraph indent CTRL+SHIFT+M 
Create a hanging paragraph CTRL+T 
Reduce a hanging indent CTRL+SHIFT+T 
Remove paragraph formatting CTRL+Q 
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Keys for editing text 
 
Delete text  
To Press 
Delete one character to the left BACKSPACE 
Delete one word to the left CTRL+BACKSPACE 
Delete one character to the right DELETE 
Delete one word to the right CTRL +DELETE 
Undo the last action CTRL+Z 
Cut to the spike CTRL+F3 
Paste the spike contents CTRL+SHIFT+F3 
 
 
Insert special characters 
To Press 
A field CTRL+F9 
Display field codes ALT+F9 
Update field codes F9 
A line break SHIFT+ENTER 
A page break CTRL +ENTER 
A column break CTRL+SHIFT+ENTER 
An optional hyphen CTRL+HYPHEN 
A nonbreaking hyphen CTRL+SHIFT+HYPHEN 
A nonbreaking space CTRL+SHIFT+SPACE 
A copyright symbol ALT+CTRL+C 
The registered trademark symbol ALT+CTRL+R 
The trademark symbol ALT+CTRL+T 
 
 
 
Move the insertion point 
To Press 
One character to the left LEFT ARROW 
One character to the right RIGHT ARROW 
One word to the left CTRL +LEFT ARROW 
One word to the right CTRL +RIGHT ARROW 
One paragraph up CTRL+UP ARROW 
One paragraph down CTRL+DOWN ARROW 
Up one line UP ARROW 
Down one line DOWN ARROW 
To the end of the line END  
To the beginning of the line HOME 
To the top of the window ALT+CTRL+PAGE UP 
To the end of the window ALT+CTRL+PAGEDOWN 
Up one screen (scrolling) PAGE UP 
Down one screen (scrolling) PAGE DOWN 
To the top of the next page CTRL PAGE DOWN 
To the top of the previous page CTRL PAGE UP 
To the end of the document CTRL +END 
To the beginning of the document CTRL + HOME 
To a previous revision SHIFT+F5 
To the location of the cursor when the 
document was last closed 

SHIFT+F5 

 
 
 
Move around in a table 
In a table, to move to the  Press 
Next cell in a row TAB 
Previous cell in a row SHIFT +TAB 
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First cell in a row ALT+HOME 
Last cell in a row ALT+END 
First cell in a column ALT+ PAGE UP 
Last cell in a column ALT+ PAGE DOWN 
Previous row UP ARROW 
Next row DOWN ARROW 
 
 
Insert paragraphs and tab characters in a table 
To insert Press 
New paragraphs in a cell ENTER 
Tab characters in a cell CTRL +TAB 

 


